Final Cut Pro X

How it Works
A new type of manual - the visual approach
version 2012-0717

from the GEM series
Graphically Enhanced Manuals
by Edgar Rothermich

pdf file available at
www.DingDingMusic.com/GEM
About the Author

Born in Germany, Edgar Rothermich studied music at the University of Arts in Berlin and graduated in 1989 with a Master's Degree in piano and sound engineering. He worked as a composer and music producer in Berlin and moved to Los Angeles in 1991 where he continued his work on numerous projects in the music and film industry ("The Celestine Prophecy", "Outer Limits", "Babylon 5", "What the Bleep do we know", "Fuel", "Big Money Rustlas").

For the past 20 years Edgar has had a successful musical partnership with electronic music pioneer and founding Tangerine Dream member Christopher Franke. Recently in addition to his collaboration with Christopher, Edgar has been working with other artists as well as on his own projects.

December 2010 marked the release of his first two solo albums "Why Not Electronica" and "Why Not Electronica Again" followed by "Why Not Solo Piano", the first release in 2011. They are available on Amazon and iTunes.

In addition to composing music, Edgar Rothermich is writing technical manuals with a unique style, focusing on rich graphics and diagrams to explain concepts and functionality of software applications under his popular GEM series (Graphically Enhanced Manuals). His bestselling books are available on Amazon, on the iBookstore and as pdf downloads.

www.DingDingMusic.com
GEM@DingDingMusic.com

About the GEM (Graphically Enhanced Manuals)

UNDERSTAND, not just LEARN

What are Graphically Enhanced Manuals? They're a new type of manual with a visual approach that helps you UNDERSTAND a program, not just LEARN it. No need to read through 500 of pages of dry text explanations. Rich graphics and diagrams help you to get that "aha" effect and make it easy to comprehend difficult concepts. The Graphically Enhanced Manuals help you master a program much faster with a much deeper understanding of concepts, features and workflows in a very intuitive way that is easy to understand.

About the Formatting

Green colored text indicates Key Commands. I use the following abbreviations: sh (shift key), ctr (control key), opt (option key), cmd (command key). A plus (+) between the keys means that you have to press all those keys at the same time. sh+opt+k means: Hold the shift and the option and the K key at the same time.

Brown colored text indicates Menu Commands with a greater sign (>) indicating submenus. Edit > Source Media > All means "Click on the Edit Menu, scroll down to Source Media and select the submenu All.

Blue arrows indicate what happens if you click on an item or popup menu

About the Editor

Many thanks to Chas Ferry for editing and proofreading my manuals. www.hollywoodtrax.com

The manual is based on Final Cut Pro X v1.0.5
ISBN-10: 1463775261
Copyright © 2012 Edgar Rothermich
All rights reserved
<table>
<thead>
<tr>
<th>Concept</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Video Editor - Workflow</td>
<td>4</td>
</tr>
<tr>
<td>Where are the Documents?</td>
<td>4</td>
</tr>
<tr>
<td>Key Elements: Events - Projects</td>
<td>6</td>
</tr>
<tr>
<td>GUI</td>
<td>8</td>
</tr>
<tr>
<td>Media Files</td>
<td>9</td>
</tr>
<tr>
<td>The Three Incarnations</td>
<td>9</td>
</tr>
<tr>
<td>Properties</td>
<td>10</td>
</tr>
<tr>
<td>Inspector</td>
<td>11</td>
</tr>
<tr>
<td>Events</td>
<td>12</td>
</tr>
<tr>
<td>Import to Events</td>
<td>12</td>
</tr>
<tr>
<td>Event GUI</td>
<td>13</td>
</tr>
<tr>
<td>Importing Files</td>
<td>15</td>
</tr>
<tr>
<td>Types of Import</td>
<td>15</td>
</tr>
<tr>
<td>Import Procedure</td>
<td>17</td>
</tr>
<tr>
<td>Camera Import</td>
<td>15</td>
</tr>
<tr>
<td>File Import</td>
<td>15</td>
</tr>
<tr>
<td>Drag-and-Drop from Media Browser</td>
<td>15</td>
</tr>
<tr>
<td>Drag-and-Drop from Finder</td>
<td>15</td>
</tr>
<tr>
<td>Import Overview</td>
<td>24</td>
</tr>
<tr>
<td>Event Management</td>
<td>25</td>
</tr>
<tr>
<td>Projects</td>
<td>26</td>
</tr>
<tr>
<td>Project GUI</td>
<td>27</td>
</tr>
<tr>
<td>Project Library</td>
<td>28</td>
</tr>
<tr>
<td>Create a Project</td>
<td>28</td>
</tr>
<tr>
<td>Change Project Properties</td>
<td>28</td>
</tr>
<tr>
<td>Manage Projects</td>
<td>28</td>
</tr>
<tr>
<td>Project Timeline</td>
<td>31</td>
</tr>
<tr>
<td>GUI</td>
<td>31</td>
</tr>
<tr>
<td>No More Sequences</td>
<td>31</td>
</tr>
<tr>
<td>Primary Storyline</td>
<td>31</td>
</tr>
<tr>
<td>Advanced Timeline Features</td>
<td>31</td>
</tr>
<tr>
<td>Clips</td>
<td>34</td>
</tr>
<tr>
<td>The Viewer</td>
<td>34</td>
</tr>
<tr>
<td>Clips</td>
<td>35</td>
</tr>
<tr>
<td>Clip Appearance</td>
<td>35</td>
</tr>
<tr>
<td>Shortcut Menus</td>
<td>35</td>
</tr>
<tr>
<td>Playing Clips</td>
<td>35</td>
</tr>
<tr>
<td>Event Clip and Subclip</td>
<td>38</td>
</tr>
<tr>
<td>Define a Range</td>
<td>38</td>
</tr>
<tr>
<td>3 Types of Subclips</td>
<td>38</td>
</tr>
<tr>
<td>Create Subclips</td>
<td>38</td>
</tr>
<tr>
<td>Markers</td>
<td>42</td>
</tr>
<tr>
<td>Editing</td>
<td>43</td>
</tr>
<tr>
<td>Placing a Clip</td>
<td>43</td>
</tr>
<tr>
<td>Trimming a Clip</td>
<td>50</td>
</tr>
<tr>
<td>Basics</td>
<td>50</td>
</tr>
<tr>
<td>Trimming the Clips</td>
<td>50</td>
</tr>
<tr>
<td>Advanced Editing</td>
<td>50</td>
</tr>
<tr>
<td>Adding FX to a Clip</td>
<td>57</td>
</tr>
<tr>
<td>Transportation - Navigation</td>
<td>59</td>
</tr>
<tr>
<td>SMPTE Reader</td>
<td>59</td>
</tr>
<tr>
<td>Transportation</td>
<td>60</td>
</tr>
<tr>
<td>Navigation</td>
<td>61</td>
</tr>
<tr>
<td>Timeline Index</td>
<td>62</td>
</tr>
<tr>
<td>Conclusion</td>
<td>62</td>
</tr>
</tbody>
</table>
"Final Cut Pro X" is a major upgrade of Apple's successful video editing software "Final Cut Pro". It created quite an uproar when it was released in the Summer of 2011. Unfortunately, it wasn't for its ground braking new approach. Many of professional editing features were missing in the original 1.0 version and some of the new concepts didn't resonate very well with the user base. Although Apple promised that more features would come in future releases, there was still so much anger in the Final Cut community that many users switched to different software.

This was very unfortunate. Yes, Apple could have been much more forthcoming of what to expect in the new release. Maybe they should have even used the 10.0.3 version as a much more complete release candidate.

However, all that bad press and those heated discussions about the end of Apple's professional video editing software overlooked one very important detail:

**Final Cut Pro X is an amazing NEW piece of software.**

This manual will help you learn and fully understand the new concepts behind Final Cut Pro X.

As I explained in the preface, my approach in writing manuals is to provide a visual understanding to create a better foundation for the actual learning process of the application. This is even more important with an innovative product like Final Cut Pro X.

It is often harder to learn a similar software (or hardware) than a brand new one because it first requires some sort of "un-learning" of existing concepts and workflows that one has become accustomed to. Those misconceptions caused some of the frustrations with the FCP7 users. Please note, FCPX is not similar to FCP7, it is a brand new program! It is understandable that Apple wanted to keep the established trademark of "Final Cut Pro" with their new release but they didn't emphasized enough that FCPX is not just an upgrade.

Releasing a FCPX manual that just tells you where to click now in order to do the same process as in FCP7 wouldn't do it any justice. Trying to use an existing workflow can be frustrating when it doesn't work with a new application. This is often not the fault of the application itself. I hope my diagrams will help you to understand "why" you have to click somewhere and not just "where". Yes, it requires a little time investment from the user, but my visual approach will make it easy and fun to reach that level of understanding.

Once you're there, everything else will fall into place and you will master Final Cut Pro X, realizing that this is truly a professional piece of editing software.

Once you use the new concepts and features, you might not only like them but may find that they could speed up your workflow tremendously.

This manual is part one of a book series.

1. **"Final Cut Pro X - How it Works"** covers all the basics. It introduces the new concepts and interface elements along with the main editing features.

2. **"Final Cut Pro X - The Details"** covers all the rest of the features in greater detail. More importantly, the manual provides a much deeper understanding of the program and explains the underlying power of its databases and metadata. This is the new foundation that sets FCPX apart from the rest of the video editing software.

3. **"Final Cut Pro X - 10.0.3 New Features"** is an addendum that covers all the changes and new features that were introduced in FCPX version 10.0.3.
Digital Video Editor - Workflow

The main workflow in FCPx is basically the same as with any other Digital Video Editors even FCP7. We can break it down into 5 steps:

1. **Import** the Media Files into FCPx. Whatever source material you want to use (video, audio, images) has to be imported into the application first. The files are now collected in an area called the “Event”.

2. **Organize** the Media Files (as Event Clips) in a specific way to make it easy and fast to preview and select the right Clip. This is done in FCPx now in the Event window.

3. **Place** the chosen Clips onto a Timeline in a sequence which will become the movie. This area is now called “Project”.

4. **Edit** the Clips on the Timeline to fine tune the sequence by using effects and other creative tools. Expect major changes here too.

5. **Export** the Timeline as the final movie.

As we will see, FCPx changes some workflow elements from FCP7 in such a way that it is almost a new application with a new approach and not just an upgrade from FCP7.

Where are the Documents?

The first and one of the biggest changes in FCPx is with the application itself, or more accurately “the kind of application” it is. Because this change has a big impact (some would say limitation) when using FCPx, I want to go into the details.

Although all applications look the same on the “outside” (there is an icon in the Applications folder that you double click and the application launches) there are two types of apps, **Document-based** and **non Document-based**. Document-based apps let you create “something”, i.e. Word, Excel, Photoshop, FCP7, etc. What they have in common is that the app is a tool that enables you to create and edit some sort of a document that is separate from the app. That could be a word document, a spreadsheet, a song or even a movie. In a non Document-based app there is no document to open or save. Everything is contained within the app. iTunes, iPhoto or even Stickies don’t have documents that you can open or save. All the data exists as part of the app and everything is there when you launch the app.

**Document-based**

The application needs a separate document that has to be opened inside the app to edit it and save it.

**Non-Document based**

There is no separate Document needed to be opened. All the edits are done inside the app and stored by the app automatically.
<table>
<thead>
<tr>
<th>Document-based</th>
<th>non Document-based</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launching the application just launches the &quot;app&quot; without the document.</td>
<td>Launching the application itself is all it needs.</td>
</tr>
<tr>
<td>You have to open a document, edit it and save it.</td>
<td>The app doesn’t have an Open or Save command.</td>
</tr>
<tr>
<td>All the changes have to be saved to the document.</td>
<td>All the changes are automatically saved to a specific file that the application handles without the user’s interaction.</td>
</tr>
<tr>
<td>Documents can be stored anywhere in the file system. Just open the File Selector Dialog and navigate to the file.</td>
<td>The files that are required by the app and handled by the app usually have to be in a specific directory. The user doesn’t have to know it because he is not expected to alter them.</td>
</tr>
<tr>
<td>It is easy and transparent to move documents around between computers. The only requirement is that the computer has the app installed that is needed to open the document.</td>
<td>Moving “documents” around can be tricky because they are “hidden” by the app.</td>
</tr>
</tbody>
</table>

That’s why there is no Open Project or Save Project command in FCPX. With this in mind, it is important to understand the underlying file system to deal with some of the limitations of a non-Document-based application.

In the Document-based FCP7 version, all the data of a Project was saved with the Project file. That Project file included all the information where the media files were located.

In the new non Document-based FCPX version, all the data about Projects and Media File locations are held "within" the app and launch automatically based on their "existence" in an app-specific directory on the drive(s).
In the new FCPx eco-system, you have only two elements:

1. The FCPx app itself represented by the Graphical User Interface (GUI)
2. The app specific location of the FCPx files on the hard drive(s)

With the new "strictly enforced policies", FCPx lets you concentrate on the first element, the GUI. Everything can be managed from here without an extra trip to the Finder to manage the files outside the GUI. You can stay "inside" the GUI all the time ①. All the Media Files on your hard drive that you have imported into FCPx are linked to an Event inside FCPx and all the work you do inside FCPx is saved automatically to the hard drive to specific folders ②. Even more complex file management tasks can be performed later inside the FCPx GUI.

The Import procedure is the "entrance" into that eco-system. The Export procedure is where you "leave" the system when your project is done and you save a final video to a new QuickTime video file.

Key Elements: Events - Projects

The previous picture displayed the two folders that FCPx uses to store all its data. FCPx is "connected" to those two folders:

- Final Cut Events
- Final Cut Project

Those two folders also represent the two main elements in FCPx: The Event - The Project

Here is the basic workflow again showing those two elements:
**Event**

- Media Files have to be imported into an Event. Every Clip in FCPx has to belong to an Event.
- In the Event, you organize the Clips, rename them and add additional information (reel, scenes).
- In the Event, you add Metadata to the Clips (ratings, keywords, ...) to create Subclips and searchable fields.
- The Event area is the source for Clips to be used in the Project.

**Project**

- The Project is the area where the movie Timeline resides.
- You grab the Clips from the Event area and place them on that Timeline.
- You edit the Clips on the Timeline by trimming them, using effects and other creative tools.
- You export the finished Timeline to a new Quicktime movie.

**Multiple Events - Multiple Projects**

- Inside FCPx you can create multiple Events in the Event area based on the way you want to organize your source media (Clips), i.e. different occasions, different locations, different days.
- Inside FCPx you can create multiple Projects for different movies, alternate versions or different reels.
- Both, Events and Projects are independent modules inside FCPx and the only connection is which Clips (from which Event) are used in what Project. Any Clip from any Event can be used in any Project, as long as they are available.
- And remember, there is no need to save any Event or save any Projects. Whatever you work on inside FCPx, every little trim will be automatically saved and next time you re-launch FCPx, everything will be right there.
GUI

The GUI of FCPx is made of a single window with 3 main frames (window panes) that are always visible and connected:

- **Event**: Contains the available Clips
- **Project**: Contains the Timeline(s)
- **Viewer**: To view the Clips from the Event or the Project

For some actions it is important that a specific window pane has key focus, indicated by a little lighter shade of black. When typing on the keyboard, the window with key focus will receive that command or text.

There is also a middle strip, the **Dashboard**, that functions as a toolbar with buttons and the multifunctional SMPTE timecode reader.

Here is the more detailed GUI:

There are two kinds of window panes:

- The main windows (Event Browser, Project Timeline, Viewer) are always visible and the corresponding key command (Goto) will switch the key focus to them.
- Additional windows can be toggled on-off (Show/Hide). Depending on which of the main frames they are assigned to, they will resize the rest of the window panes inside the same frame.

*This will overwrite the view of the Timeline Index and Timeline*
Media Files

The Source Media Files are the actual building blocks, the raw material, that you use to assemble your video.

Some of the main Media Files are:
- Video file: Containing video and sound
- Audio file: Containing sound only
- Image file: Containing still image only

The Three Incarnations

A Media File exists actually in three "incarnations". It is very important to understand their relationship and their function in FCPx:

1) Hard Drive ➔ Media Files

The Media Files have to be stored somewhere on your drive (or camera) so FCPx can access them for the initial import process. When you "import" files into FCPx, it creates only a reference to those files by storing their file path. All the work you do to the files are "non-destructive" edits which means FCPx NEVER alters the original file on the disk.

As you can see, it is important NOT to move a Media File after you import it in FCPx; otherwise there will be a broken link and FCPx can't find the file.

2) Event Browser ➔ Event Clips (and Subclips)

In order to use Media Files in FCPx, you have to import the files into an Event in FCPx first. When you import a file, FCPx creates a "Clip" that is a representation of the original Media File. All the imported Clips that are listed in the "Event Browser" only contain the path to their file's location on the drive and whenever you play the "Clip" in the Event Browser, FCPx actually plays back that original Media File it is linked to. The Event Browser functions as a container, holding all the Clips that are available for the Project Timeline.

The Clip stores not only the path to its related Media File but also all its Properties (format, length, etc). You can also add other information to the Clip (tags, informations) to better manage the Clips.

The Clips in the Event Browser are also called Event Clips. Subclips are different sections of an Event Clip.

3) Project Timeline ➔ Timeline Clips

All The Event Clips in the Event Browser now become the source material (building blocks) for your video that you want to create. That video is created on the Project Timeline.

By dragging an Event Clip from the Event Browser to the Project Timeline, you actually create a new Clip, the Timeline Clip, which is a reference to the Event Clip. Although the Timeline Clip is linked to the Event Clip (which is linked itself to the Media File on the disk), it contains its own set of additional properties, i.e. play only the last 5 seconds of the Event Clip, or play back the Clip in black and white or twice as fast, etc.

As you can see, it is important NOT to remove a Clip from the Event Browser once it is used in the Project Timeline; otherwise, there will be a broken link and FCPx can't find the file.
Properties

Each file has its properties (parameters, characteristics, etc). A video file, for example, has a specific format, sample rate and native resolution. An audio file has a specific format, sample rate and bit depth or embedded metadata like artist, composer, genre, etc.

Now each of the three "incarnations" (Media File - Event Clip - Timeline Clip) has their independent properties. We just saw that playing an Event Clip or a Timeline Clip is just an instruction to actually play back its linked Media File (let's leave out Rendered Files for the moment). The individual properties of the Clips act as layers that overwrite the playback properties of the original Media File with the properties from the Clip during playback. The instruction from the Clip could be:

- "Play back the Media File, but at half the speed"
- "Play back the Media file in black and white and lower the audio by 6dB"

![Diagram of media file workflow]

**Media File**

When you play back a Media File with the Finder's QuickView, it will play based on those original properties.

**Event Clip**

When you import a Media File, FCPX creates an Event Clip and inherits the properties of the Media File. The Inspector (an additional window pane in FCPX) displays those properties.

FCPX lets you change those properties in the Inspector and even add additional properties to that Event Clip. Please keep in mind that those changed or added parameters are now the properties of the Event Clip and are stored within the Event file that FCPX creates. The original Media File on the drive is not altered. The purpose for those additional properties is mainly to manage and organize the Event Clips so you can search and find a specific Clip later among hundreds or maybe thousands of Event Clips in the Event Browser. Some of those Properties could be:

- Additional Text Info: Reel No, Scene Number, Date, Location
- Tags: Ratings, Markers
- Keywords: Descriptive words or phrases
- Analyzed Data (automatically performed by FCPX): i.e. Excessive Shake, how many people in the shot, etc.

**Timeline Clips**

When you drag an Event Clip (or a section of it, called a Subclip) from the Event Browser onto the Project Timeline, a Timeline Clip will be created that inherits all the properties of the Event Clip at the time of the "dragging". When you open the Inspector for that new Timeline Clip, you will see those same parameters.

But now you can apply all kinds of visual or acoustic changes to the Clip by adding Effects to that Timeline Clip. Those changes will affect only that specific Timeline Clip on the Timeline and not the Event Clip or even the original Media Files. And again, all the parameters are just non-destructive playback parameters.

**Reveal in Finder - Reveal in Event Browser**

**Ctrl-click** on the Event Clip opens the Shortcut Menu with a command "Reveal in Finder" to view its associated Source Media File and **ctr-click** on a Timeline Clip provides a command "Reveal in Event Browser" to reveal the Event Clip it was dragged from or "Reveal in Finder" to even display its Source Media Clip.
**Inspector**

The concept of an Inspector is used in many applications. You select an object inside the app (word processor, graphics app) and the Inspector window displays the properties (parameters) of that object and lets you change those parameters.

FCPx uses the same concept. You can open the Inspector window in FCPx as part of the single window UI with the key command **cmd+4**. Now when you select a single selected Event Clip or Timeline Clip (or even the Project itself), the window will:

- Display the properties of the selected Clip
- Let you make changes to the properties of the selected Clip
- You can even select multiple Clips. The Inspector will then indicate if a specific parameter is different between the selected Clips.

The Inspector changes slightly depending on what object is selected. For Clips, it has three separate tabs:

- **Info** contains the main file info, read-only Metadata and additional writable fields. You can even create your own customized fields. And of course you can search for those fields like a mini database.
- **Audio** contains all the audio related properties. All the applied audio FX will be listed here and can be edited. Each individual FX module can be bypassed.
- **Video** contains all the video related properties. All the applied video FX will be listed here and can be edited. Each individual FX module can be bypassed.

Other Objects like Titles or the Project, have different tabs and parameters but the concept is basically the same.
Import to Events

As we saw earlier, the first step when creating a video is to import the Media Files into FCPx, into an Event, to be specific.

This is the new rule now:

Media Files have to be imported into an Event

This is one fundamental difference to earlier versions of FCP where you could just drag files into a bin and move the ClipClips around.

FCPx is much more restricted. Every Source Media File has to belong to a specific Event which is like a container of Clips. There cannot be a single Clip in FCPx that is not assigned to an Event. You can create, however, different Events, move Clips between them or import the same Media File to multiple Events.
Event GUI

Based on the fundamental role of the Event in FCPx, it has been assigned its own window pane, one of the three main window panes that are always visible in FCPx's single window GUI; the other two panes are Project and Viewer.

The upper left pane of the single window GUI is the Event pane that is always visible.

The Event pane can be placed on a second connected screen. You can assign a Key Command for that or use the command from the Main Menu: Window > Show Events on Second Display

To put it back, use Window > Show Events in the Main Window

The Event Pane has three sections:

- **Event Library**
  Lists all the available Events that FCPx can find in its pre-defined locations. This section can be hidden.

- **Event Browser**
  Lists all the Clips from the Event(s) that are selected in the Event Library. The Event Browser can be toggled between two views:
  - **Filmstrip View:** This is similar to the Finder's Icon View. Every Clip is displayed as an individual film strip made of thumbnail images.
  - **List View:** This is actually a combination of List and Icon View, similar to Cover Flow in iTunes where you have a List View and whatever item is selected in the list (in this case the filmstrip) will be displayed on top of the list as a Thumbnail Clip.

- **Event Toolbar**
  Displays various buttons to manage the Events and their Clips.
The Event Pane provides a lot of pop-up menus and Shortcut menus (opened by \textit{ctrl+click} on the specific item or window background).

The view below is an example for a very simple setup with only one Event that contains two Clips. When working with more Events and Clips and the introduction of Metadata, the interface gets more complex but also more powerful.
Importing Files

Types of Import
There are four different ways to get Media Files into FCPx: Two by Import and two by Drag-and-Drop

**Import**

**Import What**
- Any Media File that is stored on a connected Camera (file-based camera or tape-based camera)
- An "Archive File". This is a special type of camera import that FCPx creates

**Import Commands**
- File > Import From Camera
- cmd + I
- New Event: "Import From Camera" button
- Camera button on the Dashboard

**Import Settings**

**Camera specific Settings**

**Import Files**
- Any Media File that is stored on a mounted drive
- An iMovie Project or iMovie Event Library that is stored on a mounted drive

**New Event: "Import Files" button**
The Drag-and-Drop import procedure doesn't prompt the Import window where you can choose the settings for Transcoding and Analyzing. However, the Preferences > Import window provides exactly the same settings with the same checkboxes and those settings are applied to every Drag-And-Drop import automatically in the background.
Import Procedure

1. Assign an Event

As we have seen before, FCPx demands that every source Clip is assigned to (at least) one Event. That means, before we hit the Import button, we have to tell FCPx to which existing Event we want to assign the imported media or we have to create a new Event right there. No way around that.

2. Create an Event Folder (optional)

If we create a new Event, FCPx will also create a new folder with the same name in the “Final Cut Events” folder inside the user’s Movies directory. All the files that are related to that Event are stored in that folder.

~/Movies/Final Cut Events/”My Movie”/

3. Copy the Source File

FCPx row creates an “Original Media” folder inside the Event folder. This is the location where it copies the Media Files. During the File Import you have a checkbox in the Import window where you can check that procedure. If you leave that unchecked, FCPx will only create an Alias of the Source file in the “Original Media” folder, leaving the Source file at its original location.

An Alias file won’t increase the size of your Event folder with additional copies but it is dangerous if you delete the original file later not knowing that it was used in an FCPx Event. (You can replace the alias file with its original later).

The second checkbox “Import folders as Keyword Collections,” assigns Keywords to the Clips when you import a folder with Clips (even nested folder). FCPx keeps that “organizational information” by creating a Keyword for each folder name. That Keyword is a representation of the file’s parent folder name. For each Keyword, FCPx will create also a Keyword Collection in the Event Library. The media files will be copied “flat” into the Events folder, all in that one folder without any nested folder!

4. Create an Event Clip

As we have seen in a previous chapter about the three incarnations of Media Files, FCPx creates an Event Clip during the import that is a representation of the Source Media File. That Event Clip lives inside the Event, now with its own properties.

5. Perform Transcoding

FCPx is resolution independent. You can mix and match different audio and video formats and it transcodes them on the fly.

To optimize a performance, FCPx can use up to 3 different versions of a single Clip. When playing back the Clip in FCPx, it can use the:

- **Original Media** File: That’s the original file that gets copied into the Event Folder during the import process.

- **Optimized Media** File: This is a high resolution Apple ProRes format for smoother operations.

- **Proxy Media** File: A low resolution Apple ProRes format for less demanding CPU operations and smaller file size.

The two extra transcoded copies of the original file can be created during the import process by checking their checkboxes. Keep in mind that these files can get quite big. You also can do the transcoding process later.

You have to go to the FCPx Preferences window to set which one of the three Media files is actually used during playback in FCPx.
6 Perform Analysis

FCPx can analyze the Media Files during the import (it can also be initiated later at any time).

It analyzes the Video and the Audio portion of the file and makes that data available in two ways:

- **Keywords**: FCPx can store Keywords along with the Event Clip. The Keywords can be searched for later to quickly preview Subclips that only meet those keywords. For example:
  - Show only the portions of a Clip that has one or two people in the shot; or
  - Don't show Clips with excessive camera shakes.

- **Settings**: FCPx can detect possible problems and provide settings that can be activated later in the Timeline to help fix those issues. (Again, everything is non-destructive, playback only). For example:
  - Reduce background noise; or
  - Remove audio tracks that carry no signals.

7 Where is all the stuff?

As we discussed earlier, every Event refers to its own folder inside the “Final Cut Events” folder. The name of the folder inherits the name that you give the Event and when you rename the Event in FCPx, it will automatically rename that folder in the Finder.

The Event Browser displays the content of that Event folder.

Everything that relates to the Event will also be stored inside the Event folder and FCPx expects to find its files exactly where it puts them with exactly the name it gave them. So don’t mess with that folder content in the Finder unless you know exactly what you are doing.

All the files that were created during the import can be found here in the Event folder.

- **Final Cut Events** contains a folder for each Event
  - “My Video” the name of my Event
    - **CurrentVersion.fccevent**: This is the main file that contains the data for the Event.
    - **Original Media**: The folder that contains the imported Media Files or the Alias files linking to the original Media Files.
    - **Transcoded Media**: Contains two subfolders with the transcoded version of the Media Files:
      - **High Quality Media**: Contains the high resolution version.
      - **Proxy Media**: Contains the low resolution version.
    - **Analysis Files**: Contains subfolders that group the analyzed data:
      - **Color Adjustment Files**
      - **Find People Files**
    - **Render Files** contains more subfolder with rendered files.
    - **Any other Event-related data**.

The Final Cut Events folder will automatically be stored in the following directories:

- On the Boot Drive: In the user's Movies folder “~/Movies/Final Cut Events/”
- On any other Mounted Drive: In its root directory “~/Final Cut Events/”
- On a SAN in any directory
**Camera Import**

First of all, FCPx introduces a new concept called "Archive". This is a special type of camera input (capture).

- During a regular camera import, FCPx stores the imported files on the hard drive and adds them to an Event (folder).

An Archive import stores the imported files on the hard drive but does not assign them to an Event. FCPx functions now as a capture utility to get the footage/files off the camera for later use. The file created during an Archive is a special FCPx file with the extension .farch and a silver reel icon that is stored in a dedicated folder called "Final Cut Camera Archives" in the user’s Movies directory. An Archive file is actually a Package file that you can open in the Finder and view the media files inside.

There are many different commands to start a Camera Import:

- From the main Menu: **File > Import From Camera**
- The Key Command: **Cmd-I**
- A new (empty) Event displays the "Import From Camera" button in the Event Browser.
- On the left side of the Dashboard is also a dedicated Camera button.

Any of those Commands will open the “Camera Import” window.

- The left sidebar lists two types of “devices”:
  - CAMERAS: Displays all the currently connected cameras (you can also record live video right into FCPx from your connected camera)
  - CAMERA ARCHIVES: Displays all the available archive files.

- The lower right pane displays all the files available on the selected camera. Tape-based cameras display only one pane to import.
  - You can play the file with **space** and set an in and out point with **I and O** for the import, even with Archive files.
  - The upper right pane displays the selected file and lets you preview it with its navigation buttons.

Create an Archive File during import

This button mounts the selected Archive file (once mounted, it will have an eject button in the sidebar to unmount it).

Once it is mounted you can select it and it behaves like any other file-based camera in the sidebar to import its files.

"Import All..." files, or "Import Selected..." files

This will open the next import window.
The next window is actually a sheet that slides underneath the Camera Import window. Here you make the final selections before hitting the Import button.

1 Event Assignment
This is the part where FCPx forces you to assign a specific Event for the Media Files that you are about to import.
   - **Add to existing event:**
     A pop-up menu lists all the existing Events that are available in the current FCPx.
   - **Create new event:**
     You can create a new Event right here without going back to the Event pane. Enter an Event name and select to which mounted drive you want to save the Event.

2 Transcoding
Here you check if you want FCPx to create the two additional files for each original Media File (high res and low res).

3 Analysis
Here you check if FCPx should analyze the imported files and create and store Keywords and Settings along with the Clip: Shaky video, color balance, excessive hum or loudness, close or wide shot, how many people in the shot, etc.

4 Import:
This will perform the import:
   - FCPx creates the new Event (if selected).
   - FCPx creates an Event Clip for each imported Media File and assigns it to the selected Event.
   - FCPx performs the two transcoding of each Media File (if selected).
   - FCPx performs the Analysis for Video and Audio and stores the Keywords and Settings with the created Event Clips (if selected).
File Import

There are many different commands to start a File Import:

- From the main menu: `File > Import > Files ...`
- You can also import iMovie Events or iMovie Projects: `File > Import > iMovie Projects`
- From the Event Shortcut Menus: “Import Files…”
- The Key Command: `Sh+cmd+I`
- A new Event without any Clips displays the “Import Files” button in the Event Browser

Selecting any of those commands will open a File Selector Dialog with the import settings similar to the Camera Import.

1. **File Selection**
   Select the file(s) from the standard File Selector Dialog (usual Finder navigation applies).

2. **Event Assignment**
   Assign the imported files to an Event.
   - **Add to existing Event**
     A popup menu lists all the existing Events that are available in the current FCPx.
   - **Create new Event**
     You can create a new Event right here without going back to the Event pane. Enter an Event name and select to which mounted drive you want to save the Event.

3. **Organizing**
   Check to copy the source file into the Event folders or uncheck to just create an Alias. Create Keywords from nested folder names.

4. **Transcoding**
   Check to create two additional files for each original Media file (high res and low res).

5. **Analysis**
   Check to have FCPx analyze the imported files and create and store Keywords and Settings along with the Clip.

6. **Import:**
   This will perform the file import based on the above settings.
Drag-and-Drop from Media Browser

Importing Media from the Media Browser is a little bit different:

1. **Select Photos**
   From the central Dashboard select the “Photos” button to open the Media Browser displaying available Photos.
   - You can search your current iPhoto Library right inside FCPx.
   - You can search your current Aperture Library right inside FCPx.

2. **Select Music or Sound FX**
   From the central Dashboard select the “Music” button to open the Media Browser displaying available Music and Sound files.
   - You can search and preview your current iTunes Library.
   - You can search and preview any installed sound Libraries (FCPx, Soundtrack).

3. **Drag the File to the Event**
   To import a photo or audio file to an Event, you just drag the file from the Media Browser onto the Event in the Event Library (not the Event Browser) Later we will see that you can also drag the files directly onto the Timeline.

4. **Import**
   By dragging a file from the Media Browser onto the Event, FCPx imports the files into the Event based on the “Organizing, Transcoding, Analysis” settings in the Preferences->Import window.

Hidden import process:
- Organize
- Transcode
- Analyze

You can search for and preview media files directly in the Media Browser.
Drag-and-Drop from Finder

The Drag-and-Drop from Finder procedure is a fast way to get Media into FCPx from anywhere on your drive(s):

- Select any Media File(s) in a Finder window.
- Drag the file(s) to an existing Event in the FCPx Event Library (you could also drag it directly onto the Timeline).
- The import procedure is done "behind the scenes" based on the settings in the Preferences>Import window.

Hidden import process:
- Organize
- Transcode
- Analyze
**Import Overview**

Here is an overview of all four import options.

Although you can Drag-and-Drop a file directly onto the Project Timeline without importing it first, FCPx still performs the proper importing procedure in the background based on the Import Preferences settings (Preferences>Import) and also creates the Event Clip in the Event Browser, establishing the proper Event-Project link for that Clip.
Event Management

Event Library
Here are the basic rules for the Event Library:
- All the Events that FCPx can “see” in its dedicated folders are listed in the Event Library.
- You cannot create subfolders for Events to organize them. Not in the Event and not in the “Final Cut Events” folder. It is a “flat” list.
- There is only a limited sorting option available to display the Events in the Event Library in subfolders by year and month or by drive.
- The Event itself can contain two kinds of Collections (Key Collections and Smart Collection) and also Folders. A disclosure triangle can show/hide those.
- Folders (inside an Event) can be created manually to organize Collections.
- Collections and Folders can be moved around (create nested folders) and even copied to different Events (drag-and-drop).

Although the Events are very restricted, there are a variety of commands in the File Menu to manage Events. Any change to the Event in the Event Library will also change the Event Folder on the drive. Because the listed Events in the Event Library are a representation of an actual folder with the same name in the “Final Cut Events” directory, you could do some Event “management” directly in the Finder - if you are brave and know what you are doing. Otherwise, stick to the following commands:

Duplicate Event...
Make a duplicate of the Event (for easy backup). A Dialog Window gives you the option to name it and select the drive location (if another drive is mounted). Same as opt+drag to a new drive in the Event Library.

Move Event...
Only possible if another drive is mounted to be used as a target disk. A Dialog Window lets you select the new drive. Same as cmd+drag to a new drive in the Event Library.

Merge Events...
Select two or more Events in the Event Library and choose that command to merge them together into a new Event. You can also drag one or many Events onto another Event in the Event Library to merge them together.

Delete Event Render Files...
A dialog window lets you choose between “All Render Files” or “Unused Render Files Only”.

Organize Event Files...
This command copies all the Source Media Files into the Event folder that had only Alias files there before. This is important to avoid potential broken links with Media Files that are located outside the Event folder.

Move Event to Trash
This removes the Event from the Event Library and moves the actual Event Folder into the Finder’s Trash bin.

Reveal in Finder
This command is available from the Shortcut Menu of each Clip. It opens the Event folder in the Finder to display the Source Media File. If the file wasn’t copied during the import then it displays the Alias files.

Copy Event Clips between Events
You can also copy individual Event Clips between Events. Just drag an Event Clip from the Event Browser to a different Event in the Event Library.
Projects

Now that we have a basic understanding of the first big component in FCPx the Event, let's look at the other component, the Project.

The main task of the Event is to collect (import) the media files, organize them and prepare their use in the video. It provides the source material to create our video. The actual creation however is done in the Project. The main steps are:

- Grab the chosen Clips from the Event(s) and organize them in sequence on the Timeline.
- Edit the sequence: Trim the Clips, add effects and other creative treatments.
- When finished, export the final video as a new quicktime file.

You can work for days or weeks in the Event area creating Events and organizing your Clips without having started on a single Project. Remember you are collecting Media Files without any concerns about their different formats. Later, when we start with the actual Project, FCPx will conform any frame size, frame rate or sample rate to a unique Fender Format that we can choose and even change at any time (with some minor restrictions).

Note: The Project itself doesn't store any Media Files or Aliases of the Media Files (that's the job of the Event).

The Project stores only references to the Event Clip in an Event and that Event Clip has a reference to the original Source Media File.

The same way that an imported Clip cannot exist without a reference to an Event, a Project too cannot exist without a reference to at least one Event. FCPx won't let you create a Project without a reference to a Default Event.
Project GUI

As we know by now, the Project pane is one of the three main window sections in FCPx that is always visible.

While every other window pane has its main sections with additional window elements that can be shown or hidden, the Project pane is different. It lives a double identity with two different views:

- **Project Library**: This is the first view when no Project has been created yet. It prompts you to create your first Project. That Project and any other Project created later (that FCPx finds in the dedicated “Final Cut Projects” folder) will be displayed here.

- **Project Timeline**: This view is the actual work place where you compile your video. The Timeline View has an optional window element that can be shown/hidden, the Timeline Index.

You can toggle between the two Project views with the Key Command `cmd+0` or the film reel button in the lower left corner on the Project’s Toolbar strip.

The Media Browser and Audio Meters can be toggled in the Project Library and Timeline view.

The Project Toolbar is the Strip at the bottom of the Project pane that displays various buttons, controls and infos depending on the Project Library or Project Timeline view:

- **Project Toolbar in Project Library view**
- **Project Toolbar in Project Timeline view**
Project Library

It is important to point it out again: Projects cannot be loaded manually into FCPx. FCPx automatically "lists" all the current Projects, and only those that it can find in pre-defined locations ("Final Cut Projects" folder). There is also no "Save Project" command. Any changes made in the Project are saved automatically and immediately to various files in its Project folder.

The Final Cut Projects folder will automatically be stored in the following directories (if selected):

- On the Boot Drive: In the user's Movies folder "/Movies/Final Cut Projects/"
- On any other Mounted Drive: In the root directory "/Final Cut Projects/"
- On a SAN in any directory

Each Project is represented by an identical named folder inside that "Final Cut Projects" folder or in a nested subfolders. Here is a big difference. Projects can be organized in subfolder in the Project Library, Events can only exist on one level in the Event Library.

The Project Library window in FCPx lists each Project that it can find in any of the Final Cut Projects folder as a single filmstrip with a header on the left displaying the Project name, duration, last update and also its relative location inside a drive's Final Cut Project folder.

Next to the header is the large single filmstrip displaying the Project movie with a series of thumbnail images of that Project. Those filmstrips represent the complete Timeline of each Project and you can play them right there.

- Folder button: Create a new folder in the selected location
- Plus button: Create a new Project in the selected location
- Toggle Project view: Project Library - Project Timeline
Create a Project

Before we get into the actual video creation on the Timeline, let's have a look at the initial creation of a Project.

The + button in the Project Library toolbar lets you create a new Project. It is important to select the right hard drive or subfolder in the Project Library because that will be the location of your new Project. If you want to place the Project into a subfolder you can create the folder(s) first with the Folder button. However, you can later drag Projects and folders freely around in the Project Library.

When you click the + button, a settings sheet will open up where you set the properties for the new Project:

- **Name**: This will set the name of the Project and also the name of the Projects folders in the “Final Cut Projects” folder. You can rename the Project later at any time.

- **Default Event**: You have to assign at least one Event to the Project called the “Default Event”. However, you can later use Clips from any other available Event. Those other “used Events” are called “Referenced Events”.

- **Video Properties**: When leaving it at “Set automatically”, FCPX does not set the Project Properties when you create the Project, but later at the time when you drag your first Event Clip onto the Project Timeline. FCPX looks up the video properties of that Clip and uses those as the Project Properties. Choosing the Custom button expands the window where you manually set the Format, Resolution and Frame Rate.

- **Audio Properties**: You can leave it at the default setting (Surround, 48k) or choose Custom to select from the popup menu.

- **Render Properties**: You can leave it at the default settings (Apple ProRes 422) or choose Custom to select different settings. This is the format that the video in your project will be rendered to (during the background rendering process).

It is a good idea to choose the settings based on the format you plan to use for your final video export. However, all those settings can be changed at any time without a problem, except the video frame rate which could cause your Clips to shift in the Timeline.
**Change Project Properties**

You can change the Project Properties at any time by selecting the Project and open the Inspector with `cmd+4` or click the "I" button in the Dashboard.

The Properties Tab displays the following info:
- The Name of the Default Event and the other Project Properties.
- The General section displays the location and the last modification date of the Project and lets you enter some Notes.
- Other Events that are used by this Project are listed under "Referenced Events". The button "Modify Event References" opens a settings sheet where you change the order of Events and therefore the priority if you have multiple Events in your Project that link to the same Media File.
- Wrench (Project Properties Button): This button in the lower right corner opens the same Projects Properties Settings window that we have seen when we first created a Project. Now you can change all those Project Properties (maybe not the Frame Rate).

**Manage Projects**

- **Rename** Projects or Folders by clicking on its name in the Project Library. This will also rename the corresponding Project folder or nested folder in the Finder.
- **Move** Projects or Folders: Just drag-and-drop Projects or Folders in the Project Library. This will also move the corresponding Project folder or nested folder in the Finder.
- Three more actions are available from the Project Library’s Shortcut Menu: **Opt+click** or select from the File Menu, if Projects have key focus. Keep in mind that the File menu changes its content based on what object or window is selected (Event or Project Library).
  - **Duplicate Project** ... opens a settings window.
  - **Consolidate Project Media** ... opens a settings window.
  - **Move Project to Trash** removes the selected Project or Folder from the Project Library and moves its corresponding files in the Finder to the Trash.
- The File Menu lists the same commands plus three more:
  - **Move Project** ... to a different drive.
  - **Organize Project Files** ... (this feature doesn’t seem to work in v1.0)
  - **Delete Project Render Files** ... to save space. They can be re-rendered later again.
Project Timeline

Let’s have a look at the Timeline, the center piece of your work where you create your new video. FCPx uses a slightly different approach than other Video Editing software, including its predecessor FCP7.

GUI

The center of the Project Timeline GUI is of course the Timeline where you place the Clips.

Timeline History

Those arrows let you quickly switch to the previous or next Project without switching to the Project Library window. You can step only through the Projects that have been selected (kind of “active in the background”) after you launch FCPx. The name of the visible Project is displayed next to the arrows.

Skimming

This is a scrubbing feature where you move the mouse over a Clip and the Clip plays back corresponding to the position of your mouse and the speed of your mouse movement. The play position is indicated by a red Skimming Bar on the Clip.

Skimming Audio

This lets you turn off the audio skimming if you need only a visual reference without the “noise”.

Solo

This solo’s the audio portion of the selected Clip. Audio from other non-selected Clips is muted.

Snap

When enabled, dragged objects or the Playhead or Skimmer will snap to the nearest object or Playhead.

Timeline Index

The Timeline Index is a window pane that slides out from the left of the Timeline window. It lists all the Clips used in the displayed Project. Use the filter buttons on the bottom and the search box to restrict the displayed list. Select the “Tags” tab to only display the Keywords, Ratings and Markers that are used in the current Clips. Select the “Roles” tab for using the powerful Roles feature (see the “Details” manual). The selected item(s) in the list will be indicated in the Timeline with a white border around the Clip’s range.
No More Sequences

Prior to FCPx, each Project (the wedding video, your vacation video or your next blockbuster movie) was represented by a document file that you opened, saved, and closed similar to text documents in a word processor. Each project contained all the related media files and you edited your video on a regular Timeline. Each Project could also have multiple Timelines, called Sequences. When you wanted to edit a different version of your project (short version, outtakes, alternatives), you just created a new sequence which gave you a new Timeline for that alternate video edit. Everything stayed with that one Project and when you saved it, all the sequences were saved with it.

FCPx, totally different story. One Project - One Timeline. And there are no Sequences anymore! As we learned earlier, FCPx automatically displays all the Projects that it currently "sees" on your drive(s). All your available Media Files, organized in Events, are available right there. You are basically working in one big FCPx “über-Project”. If you want to start a new Timeline (formerly known as Sequence) to create an alternate version, you have to create a new Project. One option to imitate the Sequence concept is to organize the Projects in nested folders, but still One Project - One Timeline.

Primary Storyline

And here is another new approach in FCPx: Standard Video Editor applications work with the concept of tracks on a Timeline. Using that approach, you could create a few video tracks and even more audio tracks to position your video and audio clips on and arrange them in the correct sequence.

But FCPx uses a new approach with Storyline and Connected Clips

Here are some of the fundamental changes:

- Instead of multiple tracks in the Timeline, there is only one “track”, called the Primary Storyline.
- There is no distinction anymore between video and audio tracks. They live together identified by their color code.
- Layered Clips are not placed on parallel tracks, they are now “connected” to the Clip on the Primary Storyline, becoming Connected Clips. When moving a Clip on the Primary Storyline, all its connected Clips move along with it staying perfectly in sync.
- Video Clips that include audio tracks don't have to be split in their separate video and audio content. They can be treated (placed, moved, trimmed) as one composite Clip. They can be extracted and edited separately if needed.
So Clips don’t get placed on tracks. Instead, they “live” in two main areas:

- **On the Primary Storyline**
  
  It is technically a single track or a main track where you place your Clips.

- **Outside the Primary Storyline** (above or below)
  
  Any additional Clip, video or audio, is now placed parallel to the storyline, not onto a separate track. This will connect them to the Clip on the main track, the Primary Storyline.

  ![Timeline with Clips on the Primary Storyline and Connected Clips attached to Clips on the Primary Storyline](image)

  ![Timeline with Clips on the Primary Storyline](image)

  ![Connecting Lines](image)

- The Connected Clips have a “Connecting Line” that shows where they are attached to their parent Clip on the Primary Storyline. That connecting point on the parent Clip will move when you moved the Connected Clip. The connecting point at the Connecting Clip always starts at its first frame as a default but can be moved by `opt+cmd+click` anywhere on the Connected Clip (note, both Clips stay in sync, only the position of the line changes).

- When moving a Clip on the Storyline, all the Connected Clips that are attached to it will move with it and stay in sync, a big workflow improvement (with a few hidden dangers).

- Connected Clips that overlap will automatically stack on top of each other keeping their connecting line to the main Clip. Visually, everything is moving elegantly out of the way and into place when necessary.

- A video clip that has audio tracks embedded can now be treated as a single Clip to better ensure the sync between its video and audio content.

- The Clip on the Primary Storyline doesn’t have to be a video clip, it can be an audio clip too.

- The Clips on the Primary Storyline have to be attached to each other. There cannot be any gap between Clips like in previous FCP versions. Any potential gap will be automatically closed (“Magnetic Timeline”) or will be filled with a “Gap Clip”.

- There is a top to bottom priority for video clips. The top video or image Clip blocks any video or image below regardless if they are placed on the Primary Storyline or if they are Connected Clip (different story with transparency).

- Audio tracks from audio clips or video clips always mix together when stacked on top of each other.

**Advanced Timeline Features**

There are many other new Timeline features and concepts in FCPx which I cover in my manual “Final Cut Pro X - The Details”,

- Lift from Primary Storyline
- Expand/Collapse Audio
- Compound Clips
- Secondary Storyline
- Audition
- Precision Editor
- Layered Graphics Clips
- Multicam Clips
Before getting into the editing procedure, let’s understand the Clips a little bit better and the third pane in the GUI that actually lets us view those Clips, the Viewer:

**The Viewer**

The Viewer displays the Event or the Project, whichever has key focus. The Start command **space bar** will play back either the current selected Clip if the Event has key focus, or the Timeline of the selected Project (regardless of what Clip is selected on the Timeline) if the Project has key focus. The Viewer Title in the left upper corner indicates who is currently “feeding” the Viewer.

The Viewer pane can be placed on a second connected screen. You can assign a Key Command for that or use the command from the Main Menu: **Window > Show Viewer on Second Display**

Use the **View > A/V Output** option to send the Viewer to a connected Broadcast monitor.
Clips

When we do our first step and drag the first Event Clip from the Event Browser to the Project Timeline, we actually create a NEW Clip.

Remember, I made the distinction earlier that there are three incarnations of a Source File:

- **Media File** (in the Finder): The original file (video, audio or still image).
- **Event Clip** (in the Event): The Clip listed in the Event Browser that becomes a (linked) representation of the Media File after it gets imported.
- **Timeline Clip** (on the Timeline): This is the Clip in the Timeline that is linked to the Event Clip in the Event.

**Clip Appearance**

Let's have a closer look at the Clips. First of all, the Clips in FCPx look now really nice and carry more instant visual information:

- Clips with video content (video and still images) are blue and audio only Clips are green.
- The thumbnail image of the Clip will function as a mini-Viewer when using the “Skimming” feature in the Event Browser. Rolling over with the mouse will scrub the Clip (with or without audio).
- If the Clip carries audio content, it displays the audio waveform with color coded audio level information from green to yellow to red (audio clipping).

The Timeline Clip has three extra features:

- **Adjustment pop-up menu**: The Clip has a little pop-up triangle in the upper left corner that opens a menu for various clip "treatments". Those adjustments are non-destructive, playback-only data (Properties) that are stored with that Timeline Clip together with the Project. Its related Event Clip from the Event "doesn't know anything" about those adjustments.

- **Audio Volume**: A Volume line in the audio portion lets you offset the audio level between +12dB and -96 dB by dragging the line up or down. The color-coded waveform will immediately reflect the gain change so you can see if you are clipping the audio (also used for volume automation, called "Audio Animation").

- **Audio Fade Nodes**: A Clip that has audio content will display two nodes at the clip border when you move the mouse over the audio content. Dragging those nodes will create an audio fade in or audio fade out. The waveform displays a visual representation of the resulting level.
There is a separate Clip Appearance window that can be opened by clicking on the switch in the lower right corner of the Timeline window. It provides three display settings for the Timeline Clips:

- **Display Content**: Choose from six clip types with different proportions between audio and video content or none.
- **Clip Height**: Adjust the height of the Clips with the slider.
- **Show Connections**: Lets you hide the connection line from Connected Clips.
- **Show**: Choose between “Clip Names”, “Roles” or “Angles” as the displayed Clip Name.

**Shortcut Menus**

Both, the Event Clips in the Event and the Timeline Clips in the Project have individual Shortcut Menus when `ctr+click` on the Clip.

Most of the commands are advanced features that I will cover in my second Manual "Final Cut Pro X - The Details", but I want to point out a few commands that I covered earlier in the book.

- **Performs the automatic Transcode or Analyze process that are available during the Media import procedure.** This is useful for Clips that didn't get transcodded or analyzed during import.
- **Opens the Finder window for the Media File(s) that the Event Clip is referring to.**
- **Moves the Event Clip AND the original Media File to the Trash.** If the Event folder contains only an alias that points to the Media Files stored somewhere else on the drive, then only the Alias file will be deleted, not the Media File.

**Event Clips in Event Browser**

- New Compound Clip
- Synchronize Clips
- Open in Timeline
- Transcode Media...
- Analyze and Fix...
- Reveal in Finder
- Move to Trash

**Timeline Clips in Project Timeline**

- New Compound Clip
- Open in Timeline
- Duplicate as Audition
- Replace with Gaps
- Lift from Primary Storyline
- Expand Audio/Video
- Detach Audio
- Break Apart Clip Items
- Disable
- Solo
- Add to Soloved Clips
- Add Cross Dissolve
- Change Duration...
- Refine...
- Reveal in Event Browser
- Reveal in Finder

Opens the Event Browser and selects the Media File that the Timeline Clip is referring to.

Opens the Finder window for the Media File(s) that the Timeline Clip is referring to.
Playing Clips

FCP has two kinds of Playheads.

- **Playhead**

FCP not only has a Playhead in the Project Timeline, it also provides a Playhead directly in the Event Clip when playing back the Clip in the Event Browser. The Event Clip updates its thumbnail image to display the frame at the current Playhead position. The time will also be displayed in a little black info window that appears for a few seconds.

The Viewer (with its navigation controls) and the SMPTE Reader will display either the Event Clip in the Event Browser or the Timeline. To see which one is the current source, you have to check which one has key focus (indicated by a slightly lighter shade of black in the window color) or check its icon, displayed in the upper left corner of the Viewer.

Also note that the Playhead is white (stop mode) and turns red when in play mode.

- **Skimmer**

FCP has a second Playhead called a Skimmer or Skimming Bar. To make it visible, you have to activate “Skimming”.

Skimming is like an active scrubbing feature with your mouse cursor. Similar to an old reel to reel tape machine where in pause mode the tape is still engaged on the Playhead so when you spin the reels the audio is playing back, responding to the movement. Activating Skimming is like putting FCP in play-pause mode, any movement with your mouse will move the Skimmer. That’s why the Skimming Bar is always red. It is always “engaged” not like the Playhead which turns white when you stop playback. The Skimmer has priority over the Playhead. Hitting the space bar will start playback from the Skimmer, not the Playhead and Zoom will center the Skimmer not the Playhead.

- Toggle Skimming on/off with the Skimming button at the upper right corner of the Timeline or Key Command S. The additional feature Clip Skimming can be activated to playback only the Clip that you move over, like a solo feature (Key Command opt+cmd +S or View > Clip Skimming).

- When activated, a red Skimming Bar (called the Skimmer) appears at your cursor position when moved over a Clip (Event Clip or Timeline Clip or Project Library filmstrip).

- The Skimming Bar “follows” your cursor (position and speed) as long as you move over the Clip.

- The Viewer and SMPTE Reader display the Skimming Bar Position.

- The Event Clip also functions as a mini-Viewer with its thumbnail image.

- Toggle the Audio Skimming on/off independently with the Audio Skimming button or sh+S.

- Moving the mouse over the Event Clip or the Timeline Clip will switch key focus between Event and Project.
Event Clip and Subclip

Most of the time when choosing an Event Clip that you can use in the Timeline, you don’t need the whole Clip. Maybe there is some stuff at the beginning and at the end that isn’t useful. Maybe it’s a longer Clip that has multiple scenes or takes in it or different sections that you might use at different places in your final sequence. You go ahead and mark those sections as “Subclips”.

Creating a Subclip is easy. Select a specific Range in the Event Clip and mark that section as a Subclip, maybe giving it a suitable name so you can easily find (search for) it later. The Subclip is just an instruction that says “play the Event Clip X from time position A to time position B”.

Define a Range

Before we can create a Subclip from an Event Clip we have to learn how to set a Range.

To define a Range:

- Select the Event Clip from the Event Browser.
- Start playing back the Clip and watch it in the Viewer (or in the Clip itself that acts like a mini-Viewer).
- When the Clip reaches the position where you want to start your selection, hit the I key to mark the IN point.
- When the Clip reaches the position where you want to end your selection, hit the O key to mark the OUT point.
- You could also just draw the Range by click-drag directly on the Clip. Once a Range is displayed with yellow borders, you cannot click drag inside that marked Range anymore. To change the Range, drag its “handles” instead.
- To adjust the Range, drag the left or right handle of the marked Range, or double-click on the SMPTE Reader to enter the duration of the Range as a numeric value, thus changing its right border.

You can also use the Skimmer to move over the Thumbnail Clip and press I or O to mark the border range. Or press X to select the whole Clip as a Range. This works later also in the Timeline with the additional Key Command C to select the Clip, not the Range.

Once we have defined a Range (a section of the Event Clip), we can now mark that section as a Subclip of the Event Clip. We can define additional Subclips in this manner and mark any section of an Event Clip as a separate Subclip.
3 Types of Subclips

Now is the first time that we are getting a little bit into Metadata and related concepts. I didn’t discuss that in the Event Chapter but I want to point something out here. Many Editors might not like the new concept in FCPx with the Event and Keywords, Ratings, Smart Collections etc. They may not realize that FCPx incorporates a concept known as "Digital Asset Management" (DAM). This is used in huge databases to manage the datasets efficiently. Although mainly used in those big corporate systems (banks, manufacturing, etc), it has moved into our smaller systems like iTunes and iPhoto with their Ratings and Smart Playlists. Even the Finder with its Smart Folders and Spotlight uses those principles of Digital Asset Management to manage our ever growing data sets, (files, photos, songs, etc). Let me try to compare the old and new FCP with that aspect in mind.

Old FCP concept
You are in charge of how to manually organize your Clips. This lets you have the ultimate flexibility since you are in charge of managing the files. However, that “managing” process can become very overwhelming with the increase of files and the final goal of “finding the right Clip - fast” could be jeopardized.

New FCPx concept
You are in charge of how to describe the Clips (metadata). FCPx then finds your Clips automatically based on those descriptions and search queries. This requires an understanding of “data management” that might be unfamiliar to some people. It also means, “letting go” and trusting the system. You don’t go to a particular bin anymore, knowing that you put specific Clips there. Now you go to particular Smart Collections where the system “displays” specific Clips based on your metadata and search queries. If used in the right way the whole system becomes extremely flexible and fast. But it requires a new “mind set” from the Editor.

So let’s dive into metadata territory a little bit.

FCPx uses three types of Subclips. Although their concept is the same (they mark a sub-section of the Event Clip), they are used differently. The three kind of Subclips are like three kinds of Metadata similar to fields in a database. “Markers” are a fourth kind of metadata but they don’t describe a Subclip (a Range), just one single address (one position).

- **Analysis**: This type of metadata is created automatically by FCPx. It can analyze the Media File and look for specific characteristics, like if the camera has excessive shake (and therefore the footage might not be of any use). Or it can analyze to see when the footage has close-ups of one, two or three people in the shot. Let’s say you have two hours of raw video imported. Now with the click of a button you can go directly to the scenes that have two people in them. No need to preview the 2h manually, making notes and Clips and organizing them in bins (yes, the analyze process is automatic, so your mileage may vary regarding the accuracy). If an Event Clip has one of those, tags then FCPx automatically creates a dynamic Smart Collection (like an automatic bin) for each individual tag in the Event Library inside that Event.
  Analyzed subclips have a purple gear icon in the Event Browser.

- **Keyword**: This is a simple form of a metadata. You create Subclips by assigning them specific tags (a word or phrase). This way you can mark similar scenes (Indoor, Car Ride, Cloudy Day, etc ...) with the same tag. You can see in the Event Browser if an Event Clip has one of those Subclips. FCPx also creates a dynamic Keyword Collection (like an automatic bin) for each individual tag in the Event Library for that Event. Now with one click you can see all the “Indoor” or “Car Ride” subclips together for easy selection.
  Keyword subclips have a blue Key icon in the Event Browser.

- **Rating**: This is actually a dual Metatag. You can mark a section as **Favorite** or **Rejected**. This way you can select later all your favorite scenes or let FCPx filter out all the sections that are marked “Rejected” (shaky camera, outtakes, etc).
  Important to know that you can rename the Ratings subclip and even search for those names. You can create a Smart Collecting manually in the Event Library to include Ratings tags.
Create Subclips

1. Select the Event Clip
2. Define a Range
3. Assign a tag by either:
   - Click the button
   - Choose the Menu Command
   - Hit the Key Command
4. Optional: Rename the Subclip

Mark > Favorite
Key Command F
Optional: Rename the Subclip

Mark > Reject
Key Command delete
Optional: Rename the Subclip

Mark > Show Keyword Editor
Key Command cmd+K
The Keyword tag requires an extra step: Enter a custom Keyword into the Keyword Editor window.

The section that is marked with a tag has a colored bar indicator at the top of the Event Clip

Green: Favorite Tag
Red: Rejected Tag
Blue: Keyword Tag
Purple: Analyzed Tag

All the Subclips are listed in the Event Browser "inside" the Event Clip (with a disclosure triangle like a folder in the Finder). If you select any of the Subclips, a white border on the thumbnail marks the Range of the Subclip that reflects its length in relation to the whole Event Clip (total width of the thumbnail image).
Keyword Editor

The Key button on the Dashboard is actually a toggle button for the Keyword Editor window “open-close”. If it is grey then the Keyword window isn’t open. If you click on it then the button turns blue indicating that the Keyword window is now open.

Keyword Shortcut

The Keyword Editor has a disclosure triangle that opens the Keyword Shortcuts.

You can assign up to nine Keyword Shortcuts to the Key Commands. Next time you want to assign a Keyword to a Subclip, just select the Range in the Event Clip and hit the assigned Key Command to assign that Keyword. No need to open the Keyword Editor and type in the actual Keyword.

Removing/Converting Tags

- Remove Analysis Tag
  Opt+click on an Analysis Subclip to open its Shortcut Menu and select “Remove Analysis Keywords”.

You can also use the other commands to quickly re-assign a Favorite or Reject tag to that Subclip.

- Remove Ratings Tag
  Opt+click on a Favorite or Reject Subclip to open its Shortcut Menu and select “Unmark”.

You can also change the Subclip from Favorite to Reject and vice versa or click on the opposite Star button in the Dashboard.

The grey Star button on the Dashboard works as an “Unmark” button.

- Remove Keyword Tag
  Opt+click on the Keyword Subclip in the Event Browser to open its Shortcut Menu and select “Remove all Keywords”. All Keywords is referring to the Keywords in that particular Subclip not all the Keywords in the whole Event Clip.

You can also convert the Subclip into a Favorite or Reject tag by selecting the command from the Menu.

If you use the Menu Command Mark > Remove All Keywords, then you can select either the whole Clip in the Browser (to delete all Keywords in that Clip) or just its Keyword selection (to delete that Keywords in that section).

Selecting a Keyword Selection in the Event Browser displays that Keyword in the Keyword Editor window (if its visible). Now you can delete individual Keywords if a selection has more than one Keyword. Select it and press delete.

The Keyword Collection in the Event Library will not be deleted when you delete the actual Keyword from a Clip. That Collection can only be deleted manually with the Shortcut Menu.
Markers

There are three different kinds of Marker:

- Regular Marker
- To-Do Marker
- Completed Marker

Markers can be attached to:

- Event Clip
- Timeline Clip
- Timeline

Markers can be attached to Event Clips. They will be visible on top of the Clip and also listed in the list view "inside" the Clip together with other Metadata.

Markers can be attached to Timeline Clips. They will be visible on top of the Clip and listed in the Timeline Index together with other Metadata where they can be searched for. When an Event Clip gets moved to the Timeline, it brings its Markers with it.

Markers CANNOT be attached directly to the Timeline like in previous FCP versions.

Tip: Create a Placeholder Clip as a Connected Clip on the first frame of the Primary Storyline and extend it to the end of the Project Timeline. Now you can create Markers on that long "Pseudo Timeline Clip".

A variety of commands lets you manage Markers through Key Commands, Main Menus and Shortcut Menus:

- **Create** a Marker: Click M to create a Marker at the Playhead/ Skimmer position.
- Create Marker and Modify: Opt-M creates a Marker, stops playback and opens the Marker Window.
- **Modify** Marker: Double-click on the Marker (on the Clip or in the list) or press M again when the Playhead is on the Marker.
- **Delete** Marker: A single Marker or all the markers in a selection.
- **Nudge** Marker: You can nudge the Markers left or right by 1 frame or (1 subframe for audio only Clips). Key Command ctr+, or ctr-.
- **Copy-Paste**: Use the Cut or Copy command from the Shortcut Menu and paste cmd+V the Marker at the Playhead position.

**Shortcut Menu**

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Mark &gt; Markers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Marker</td>
<td>M</td>
</tr>
<tr>
<td>Add Marker and Modify</td>
<td>`M</td>
</tr>
<tr>
<td>Modify Marker</td>
<td>M</td>
</tr>
<tr>
<td>Nudge Marker Left</td>
<td>`</td>
</tr>
<tr>
<td>Nudge Marker Right</td>
<td>`</td>
</tr>
<tr>
<td>Delete Marker</td>
<td>`M</td>
</tr>
<tr>
<td>Delete Markers in Selection</td>
<td>`M</td>
</tr>
</tbody>
</table>

**Marker Window**

The Marker Window lets you enter a custom name and change the Marker status (Default, To-Do, Completed). It also displays the SMPTE position of the Marker and lets you delete it all together. The Window is context sensitive, that means depending on what kind of Marker you selected, it will only display options that make sense in that context:

- **A Regular Marker** opens this Marker Window -->
- **A To-Do Marker** opens this Marker Window -->
- **A Completed Marker** opens this Marker Window -->
Now that we organized all our source material as Event Clips in the Event, we can finally go to the next level and place the Clips onto the Timeline to create our video. In order to do that, we have to ask ourselves four fundamental questions:

- **What** Clip(s) from the Event Browser do we want to place onto the Timeline?
- **How** do we move the Clip, with what command or action?
- **Where** on the Timeline do we want the Clip to be placed?
- **Consequences** What are the Consequences to the existing Clips on the Timeline?

**What Clip to Select**

All the selected Clips are ready to be placed. If a Subclip is selected, then it displays its grey borders.

You can deselect the selected Clip(s) and define a new ad-hoc Range instead.
How to place the Clip

Content Filter

Whatever method you choose to place a Clip from the Event Browser to the Project Timeline, there is an important filter that you have to be aware of. Whenever you do that action, you can choose:

- **Use All**: The whole Clip, Video and Audio
- **Use Video Only**: Only the Video portion of the Clip
- **Use Audio Only**: Only the Audio portion of the Clip

Keep in mind that you always move a Clip (or Subclip) not its individual content, you just decide what is "in it". Overwriting a video+audio clip with an audio only clip doesn't just replace the audio portion, it replaces the original video and audio portion, in that case with no video.

Whatever method you are using to place a Clip on the Timeline, it always executes that command with the currently set filter. You can change the filter in three different ways (This filter doesn't apply when dragging Clips from the Media Browser or the Finder!)

- Use a Key Command: All `opt+1`, Video Only `opt+2`, Audio Only `opt+3`
- Select a Menu Command *Edit > Source Media>*
- Click on the “Triangle” in the Dashboard to select from that popup menu

Pay attention to the detail:
The buttons actually change their appearance depending on the current filter setting. This conforms with the basic FCPx color code for the Clips: video=blue and audio=green

2 ways to move:

There are basically two methods to move Event Clip(s) or Subclip(s) from the Event Browser onto the Project Timeline:

- **Commands**: You can choose from a variety of commands to move the selected Event Clip from the Event Browser directly onto the Timeline in the Project.
- **Drag-and-Drop**: You can use your mouse to drag a Clip from the Event Browser directly onto the Timeline in the Project.

* Remember that you can also drag files from the Media Browser or directly from the Finder onto the Timeline (they get automatically added to the Default Event)
How do Clips get along?

**EDITING**

Placing a Clip - Editing Clips

The Nice Way

Clips get adjusted to new situations and moved around to find "compromises"

The Bully Way

Clips get deleted and overwritten when they are in the way and gaps are left behind

This is the default behavior in FCPX when placing Clips or editing Clips on the Timeline. Existing Clips on the Timeline will automatically move out of the way when inserting new Clips. Or when moving a Clip out of a sequence or deleting it, the gap will close up, moving the rest of the Clips to the left, always guaranteeing that the Clips on the Timeline stay connected. It is the new "Magnetic Timeline".

This is the exception in FCPX when placing Clips or editing Clips on the Timeline. This time, placing a Clip on the Timeline will OVERWRITE whatever Clip is there and when moving a Clip, the rest of the Timeline Clips will not try to close the empty space, instead FCPX will leave a “Gap Clip” behind. On a side note: Nothing gets shifted on the Timeline, which might be exactly what you want sometimes.

▷ Use a Command

So how many different commands are there for placing a Clip onto the Timeline? It depends on how you count:

- There are 4 main methods: Connect - Insert - Append - Overwrite
- Three of those methods have a “variation”: Backtimed Connect - Backtimed Insert - Backtimed Overwrite

- On top of that, there are three ways to initiate the command:
  - Select a Menu Command
  - Click on a button in the Dashboard
  - Use a Key Command

  (Remember, whatever method you are using, it always executes that command with the currently set content filter)

<table>
<thead>
<tr>
<th>Commands:</th>
<th>Connect</th>
<th>Insert</th>
<th>Append</th>
<th>Overwrite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Menu:</td>
<td>Connect to Primary Storyline</td>
<td>Insert</td>
<td>Append to Storyline</td>
<td>Overwrite</td>
</tr>
<tr>
<td>Button:</td>
<td><img src="button.png" alt="Connect" /></td>
<td><img src="button.png" alt="Insert" /></td>
<td><img src="button.png" alt="Append" /></td>
<td><img src="button.png" alt="Overwrite" /></td>
</tr>
<tr>
<td>Key Command:</td>
<td>Q</td>
<td>W</td>
<td>E</td>
<td>D</td>
</tr>
<tr>
<td>Key Command:</td>
<td>sh+Q</td>
<td></td>
<td></td>
<td>sh+D</td>
</tr>
</tbody>
</table>

The “Overwrite” command follows the “bully way”. Maybe that’s why it didn’t get its own button and is only available as a command.
Use Drag-and-Drop
Instead of selecting the Event Clip(s) in the Event Browser and initiating one of the commands, you can use the mouse and just drag them down to the Project Timeline. You can make the choice by dragging exactly the item you want:

1. Select one or many Clips in the Event Browser and drag them to the Timeline. If more than one Clip was selected, then dragging one Clip will move all the selected Clips with them. You will actually see the names of the Clips while you are dragging the cursor.

2. If the selection is displayed as a white border on the Event Browser filmstrip, then you can drag inside that border to move it down to the Timeline (the border will change to a yellow Range selection).

3. You can also define an ad-hoc Range and drag that section of the Clip down to the Project Timeline.

Use Drag-and-Drop (not from the Event Browser)
The proper way in FCPx is to import the Media Files first into Events and then drag those Event Clips from the Event Browser to the Project Timeline. But there are two exceptions as we have seen in the Import chapter:

- Drag files to the Timeline from the Media Browser
- Drag files to the Timeline from the Finder

Although it looks like this violates the FCPx rules, what happens is that those files get automatically added to the Project's Default Event in the background and you are “invisibly” moving them from the Event Browser following perfect FCPx protocol.
The Import settings in the Preferences window apply to those files (Organize, Transcode, Analyze).

Where to place the Clip
Now we have all those different options on "how" to move the Clip to the Timeline. The next question is "where" exactly on the Timeline will the Clip be positioned.

Using Commands
There are two possible target positions on the Project Timeline to place the new Clip: Playhead/Skimmer or a Range (3-point Edit).

The Clip from the Event Browser will be used to be placed at the Playhead. If a Skimmer Bar is visible then its position has priority.

Only as much of the Clip(s) from the Event Browser will be used to fill up the selected Range in the Timeline. The selected Range can even span across more that one selected clip on the Timeline.
The example below illustrates the different placement of the Clip when using the regular command (connect, insert, overwrite) or the backtimed variation of those commands:

There is an exception for the Playhead position:
- The Playhead position will be ignored if you choose the Append command. The new Clip will append to the last Clip on the Timeline (Primary Storyline) regardless of the Playhead position.

> **Using Drag-and-Drop**

If you choose Drag-and-Drop to move the Clip from the Event Browser to the Project Timeline then your mouse position determines where the target position will be on the Timeline. (Playhead/Skimmer or any existing Range selection will be ignored).
Consequences

We've seen many different ways to move Clips from the Event Browser and place them on the Project Timeline. Now, let's explore the different "Consequences" on the Timeline. You have to be aware of what happens to the existing Clips on the Timeline and how they "react" to the "intruder".

And again, those consequences are different if you are using commands or drag-and-drop.

Using Commands

The new Clip (B) gets connected to the Primary Storyline at the Playhead position. The Playhead moves to the end of the new Clip (this is actually a Preference settings "Position Playhead after Edit Operation")

The original Clip (A) gets cut at the Playhead position and the new Clip (B) gets inserted, moving the rest of the Clip A to the right. Everything else after that gets moved to the right too.

The new Clip (B) gets added to the end of the LAST Clip in the Primary Storyline. The original Playhead position is ignored.

The new Clip (B) overwrites the existing Clip at the Playhead position. If Clip B is longer than Clip A, then it continues to overwrite the needed portion of the next Clip on the Timeline too.

If the Playhead is located later than the end of the last Clip on the Timeline, then FCPx inserts a "Gap Clip" first before adding the new Clip (except for the Append command).

Using Still Images

When putting a still image onto the Timeline which technically has no duration, it will create a Timeline Clip with the length that is set in the Preferences window.
Using Drag-and-Drop

There are again two different kinds of consequences when using drag-and-drop with the mouse, depending on what Tool is selected for the cursor when you drag the Clip from the Event Browser down to the Project Timeline. Click on the Tool selector button in the Dashboard to open the Tools popup menu.

1. If the Position Tool is selected

   Basically this is the easiest one. Wherever you drop the Clip on the Timeline, that is exactly where it will be. If there is anything in the way, it will be overwritten.
   
   - If you drop the Clip after the last Clip on the Timeline, then FCPx will create a “Gap Clip” to fill the space.
   - If you drop the Clip on top of an existing Clip, then that Clip will be overwritten for the duration of the new Clip (Overwrite functionality).
   - If you drop the Clip above or below the Primary Storyline, then the new Clip will become a Connected Clip (Connect functionality).

2. If the Select Tool is selected (or any other Tool besides the Position Tool)

   Now Clips are moving out of the way to make room or closing up to fix any possible gap (Magnetic Timeline).
   
   - If you drop the new Clip after the last existing Clip on the Timeline, then the new Clip will be appended to the end of the last Clip. It is not possible to create a gap, on purpose or by accident (Append functionality).
   - If you place the Clip between two adjacent Clips on the Timeline, then the right Clip (and all the rest of the Clips in the Project Timeline) will move to the right to make space for the new Clip. Everything snaps into place to make sure that there are no gaps (Insert functionality).
   - It is not possible to split an existing Clip with drag-and-drop. For that you have to use the Insert command with the Playhead.
   - If you place the Clip on top of an existing Clip, then that Clip will fade to gray and a popup menu will open with three options:
     
     1. Replace
        Replaces the existing Clip with the new Clip. The rest of the sequence will be shifted to adjust the new length, longer or shorter.
     
     2. Replace from Start
        - If the new Clip is longer than the existing Clip:
          Replaces the existing Clip with footage from the new Clip starting at the first frame for the length of the existing Clip to make sure that the length of the sequence doesn't change.
        - If the new Clip is shorter than the existing Clip:
          An Alert Window will pop up to remind you that the new Clip isn't long enough and therefore the sequence will be shortened after the replacement.
     
     3. Replace from End
        - If the new Clip is longer than the existing Clip:
          Replaces the existing Clip with footage from the new Clip starting at the last frame for as long as the length of the existing Clip to make sure that the length of the sequence doesn't change.
        - If the new Clip is shorter than the existing Clip:
          An Alert Window will pop up to remind you that the new Clip isn't long enough and therefore the sequence will be shortened after the replacement.
Trimming a Clip

Basics

Once most of the Clips are placed from the Event Browser to the Project Timeline, the next step begins - trimming the Timeline Clips. Of course, new Clips can be added to the Timeline from the Event Browser (or directly from the Finder) at any time during the editing.

Stay in Touch

The default Clip behavior on the Timeline is that adjacent Clips on the Primary Storyline stay always attached to each other without leaving a gap. Any change you make on the Primary Storyline that affects the length of the existing Clip (lengthening, shortening, inserting, removing) will automatically compensated by FCPx by nicely moving other stuff around. Sometimes you specifically need to leave a gap between Clips. For this purpose there are two kinds of Timeline-special “fake” Clips:

- Gap: This is just a black Clip on the Timeline. FCPx creates those Gap Clips automatically (under some circumstances) or you can create a Gap Clip manually with the menu command Edit > Insert Generator > Gap or Key Command opt+W. The Viewer displays a black background or any other of the choices from the Preferences > Playback settings.

- Placeholder: A Placeholder Clip is similar to a Gap but more sophisticated where you can assign it some properties (in the Inspector) to indicate what it is holding the space for (wide shot, close up, day, night etc). Create a Placeholder Clip with the menu command Edit > Insert Generator > Placeholder or Key Command opt+cmd+W.

Gap and Placeholder Clips can be named and have Metadata. They show up in the Project Index list like any other “regular” Clips.

Editing Tools:

This is the list of available mouse pointers. Use their Key Command or open the popup menu on the Dashboard and select the tool. There is also a nice “temporary tool” feature: Instead of switching the tools back and forth, you can hold the Key Command temporarily while doing the task (cutting, trimming, selecting) and when you done, let the key go and it will return to the Tool it had before.

- Pointer: Default - all purpose tool, including ripple trimming.
- Trim: For most of the trimming needs.
- Position: Move or trim Clips without affecting the Timeline. Overwriting Clips and leaving gaps behind.
- Range Selection: Select a Clip Range (even across multiple Clips).
- Blade: Like a scissor tool to split Clips.
- Zoom: Zoom in (drag) and out (opt+drag) of the Timeline. Also use click and opt+click.
- Hand: Drag the Timeline (functions like the scroll bar).
Snapping

Snap Mode snaps objects, borders or Playheads to important positions (start, end of objects, Playhead, Markers) when moving/dragging across the Timeline.

Toggle on/off with the Snap button in the upper right corner of the Project Timeline or use the Menu Command View > Snapping or Key Command N (can be temporarily toggled by holding down the N key).

Fine Trimming

Using **Cmd+drag** during any trimming or moving activity with the mouse will switch to a finer moving resolution. Moving by frames instead of seconds.

A black Info window on top of the Edit Point displays the timing offset of your movement. The window is "space conscious": so if there are only a few frames offset, it displays only the frames and not the entire set of leading zeros from a complete SMPTE time. When subframes are enabled for the SMPTE display (Preferences > Editing > Time Display), then the subframes will also be displayed after a period.

Split Screen Editing

Enable "Show detailed trimming feedback" in the Preference > Edit window to display a two-up Display in the Viewer when performing a trim with the mouse. Now the left display shows the last frame of the left Clip and the right display shows the first frame of the right Clip at the Edit Point.

You can hold down the opt key while trimming to toggle this setting, i.e. leave the two displays disabled and only activate it when you need it by holding down the opt key while performing the trim.

Selections

Please note the difference between a Clip Selection (the whole Clip) and a Range Selection (any portion of it).

**Clip Selection**

Clip Selection has a yellow border around it.

Press C when mouse over the Clip to select the whole Clip as a Selection.

**Range Selection**

Clip Range has a yellow border with rounded corners and handles on the side.

Press X when mouse over the Clip to select the whole Clip as a Range. The cursor changes to a Range tool. (Also works in the Event Browser).
Trimming techniques with Edit Points

There are a few trimming techniques that most of the video editing applications use. Those are the ones based on what part of a Clip will be trimmed and what the effect is on the adjacent Clips.

The yellow brackets represent the Edit Point. That’s the to be edited part of the Clip(s).

- **Ripple:** You shorten or lengthen one end of the Clip (left or right) while the adjacent Clip(s) stay “attached” meaning that they get moved to the left or the right on the Timeline to compensate the time difference. (except with the Position Tool). The rest of the Timeline will shift.

- **Roll:** You move two adjacent borders of two Clips together. So one Clip gets shortened while the other one gets lengthened or vice versa. Surrounding Clips will not be affected. The Timeline stays untouched.

- **Slip:** You are not moving the Clip. The length of the Clip stays the same and the surrounding Clips and the rest of the Timeline stays untouched. You are only moving the “portion of the media” underneath the Clip, if there is footage available on both ends.

- **Slide:** This time the Clip in itself stays untouched (same in, out, length) but you move it as it is to the left or the right on the Timeline. Therefore the edges of the Clips to the left and to the right are shortened or lengthened.

End of Range:

The yellow Edit Point turns to a red border to indicate that there is no more footage at that end of the Clip.

Potential danger with Connected Clips

- You have Clip A followed by Clip B. Clip A has a connected Clip C that stays in sync wherever you move Clip A

- When you shorten Clip A, Clip B will follow (Ripple or Roll). However the Connected Clip C has the “rug pulled out from under it,” because it stays in sync with the Timeline and finds a new “mate”, Clip B, which it happily attaches to.

- If you extend Clip A, Clip B will be shortened, but this time the Connected Clip C decides to stick with Clip B and moves with it!

If you did those three steps just to try an edit and you didn’t pay attention, then you would have moved Clip C out of its original position. If Clip C was a SFX or a cued music track, then ... you are in potential trouble.
Trimming the Clips

What are the different trimming techniques? There are so many and many different ways to do similar techniques that it can be a bit overwhelming. Here are just a few:

- **Mouse**: Just slide around the edges of the Clip that you want to trim with the mouse and the correct pointer tool.
- **SMPTE**: Enter a precise time value of how much you want to trim.
- **Nudging**: Use Key Commands with predefined time values.
- **Playhead/Range/Duration**: Use the Playhead or a selected Range for the trim position, or enter a Clip duration.
- **Split**: Cut up an existing Clip at a specific edit point.

So in all, how many methods are available, and which one is the best to use? More importantly, do they have different effects or limitations?

Let's divide all these trimming techniques into two groups: Editing with commands and editing with the mouse:

![Diagram showing How to perform the edit with Command and Mouse](image)

Select the Target object first and then use a Key Command or a Menu Command to perform the edit.

Use the mouse and perform the edit directly on the object with the appropriate mouse movement and cursor selection.

### Using Commands

When using a command (Key Command or Menu Command), you have to be aware of what the target object will be for your command. That depends mainly on what is selected. It sounds trivial but being aware of who is affected by the command you are using is very crucial because the same command can have different effects depending on what is selected:

1. **Nothing** is selected
2. **Clip** is selected
3. **Range** is selected
4. **Edit Point** is selected

#### 1) Nothing is selected

In this scenario, only the position of the Playhead or Skimmer determines the actual trimming.

- **Trim Start**: The topmost video clip in the Timeline at the Playhead/Skimmer gets its left edge trimmed to the Playhead/Skimmer position. Any gap will be closed. Key Command `opt-$` or Menu Command `Edit > Trim Start`.
- **Trim End**: The topmost video clip in the Timeline at the Playhead/Skimmer gets its right edge trimmed to the Playhead/Skimmer position. Any gap will be closed. Key Command `opt+]` or Menu Command `Edit > Trim End`.
- **Blade**: The Clip on the Primary Storyline at the Playhead/Skimmer gets cut at the Playhead/Skimmer position, creating two Clips. No change in the Timeline. Key Command `cmd+B` or Menu Command `Edit > Blade`. 
2) A Clip is Selected

In this scenario only the selected Clip will be affected:

- **Duration:** Changing the duration of a Clip is the same as trimming the end of a Clip. There are four ways to initiate that command. **Double-click** on the SMPTE Reader to enter the duration as an absolute time value, use the Shortcut Menu command when **crt+click** on the Clip, use the Key Command **crt+D** or the Menu Command **Modify > Change Duration**...

- **Move by Nudge value:** This moves the selected Clip(s) left or right by the nudge value amount (connected Clips will move in sync). Be careful because this is the “bully way” of editing: Every Clip in the way will be overwritten and potential gaps are left behind. Connected Clips in the way will be “taken over”!
  - Nudge 1 frame left or right with `,` and `. ` (the keys with the < and > character)
  - Nudge 10 frames left or right with the Key Command **sh+`, (shift and the comma key) and sh+**.
  - Nudge 1 subframe (1/80 frame) left or right with **opt+`, (option and the comma key) and opt+**.

- **Move by numerical value:** When a Clip is selected and you hit the `+` or `-` Key, the SMPTE Reader changes to a numeric value input device. Although the little graphic looks like a “Slide” symbol, this command is NOT a Slide Edit. It is again the “bully way” of editing: Every Clip in the way will be overwritten and potential gaps are left behind.

- **Delete:** The selected Clip(s) will be deleted and any gap will be closed up by the surrounding Clips. Be careful, deleting a Clip on the Primary Storyline will also delete all its Connected Clips.

3) A Range is Selected

In this scenario the Range selection is used as a guide to trim like there would be one Playhead for the start trim and one for the end trim.

- **Trim To Selection:** Use the Menu Command **Edit > Trim to Selection** or the Key Command **opt+\ (you can also use the `+` and `-` Key to change the duration of the Range)**.

4) Edit Points are Selected

In this scenario you select the specific Edit Point with the Trim Tool first and then type in the SMPTE Reader the time amount that you want to shift the Edit Point.

This method is for more precise trimming.

1. You click on the area with the trimming tool to get the yellow border (indicating what trimming technique will be performed on what Clip).
2. Enter the amount you want to trim in numeric numbers on the keyboard. The numbers, including a graphical indication of the trimming mode, will be displayed in the SMPTE Reader.

   Click `+` or `-` if you want to move to the left or right, followed by the number entry. Start from right (frames) to left. “23” means “23 frames”, “213” means “2sec 13frames”. Use the decimal point as a value divider “1,” means “1 sec 00frames”. **Use eec** to abort the process.

   - The number entry has some sort of intelligence: If you work in a 30f format and you type in “35”, the display will automatically display “1s 5frames.”

   * Remember, if a Clip is selected instead of the Edit Point, then the SMPTE displays the Slide symbol when pressing `+` or `-`, but it is actually performing a “Position Move”.

**Extend Edit** is an additional command that moves the selected Edit Point (the yellow bracket) to the current Playhead/Skimmer position. Use the Menu Command **Edit > Extend Edit** or the Key Command **sh+X**.
Using the Mouse

The trimming with commands allows very accurate editing but it requires a two step process of selecting the target first and then applying the command. Trimming with the mouse on the other hand is a more direct and intuitive method because you are performing your edit right there at your finger tips. The mouse cursor in FCPx is now much more flexible, changing its function (and appearance) depending on where you move the mouse over (location aware). It requires much less switching of the Pointer Tools. You can even temporarily switch to a different Pointer Tool by holding down the same key that you would normally use to permanently change to that pointer, perform the action and then release the key. The important thing however is that you always have to be aware of what the current selected Pointer Tool is.

Edit Points

Trim Tool (Select Tool)

The Trim Tool provides all the trimming functionality but even the default Select Tool provides basic Ripple trimming without the need to switch the cursor to the Trim Tool:

- Ripple: Click close to the border of a Clip with the Trim Tool T. Ripple will also work with the basic Select Tool A, so no need to actually switch tools for that.
- Roll: Click between two adjacent Clips with the Trim Tool T.
- Slip: Drag the Region left or right with the Trim Tool T.
- Slide: Opt+drag the Region left or right with the Trim Tool T.

The mouse cursor automatically changes to a different icon when moved over specific areas of the Clip to indicate the current trimming mode.

Position Tool

This is the editing mode where FCPx does not try to fill any gaps or move Clips out of the way to make room for an inserted or extended Clip ("Magnetic Timeline function off"). If the Position Tool is selected, any action (moving, trimming, etc) will result in an overwrite of existing Clips or the creation of a Gap Clip. This however has a side effect that might be exactly what you want: The Clips on the Timeline won’t shift! Yes you are overwriting Clips but FCPx will not shift Clips along the Timeline that you don’t want to be shifted in the first place. Your Clips always stay in place.

- Trimming: The mouse cursor automatically changes to one of several different icons when moved over specific areas of the Clip to indicate the current trimming mode.

Split Clips

Blade Tool

This trimming command allows you to split a selected Clip in two. Note that this Tool has its built-in Skimming bar so you can see in the Viewer and the SMPTE Reader where you split the Clip. If the Blade is moved over a Clip (active), then it turns black. When moved anywhere else on the Timeline, it changes to a red blade (inactive). Shouldn’t that be the other way around?

- Split: Clicking anywhere on a Clip will split the Clip at that position into two. This works on any Clip, Primary, Storyline or Connected Clip.
Moving Clip
Besides trimming Clips in their position, of course you can also move Clip(s) around.

- **Move any Clip(s) with Pointer Tool:** Drag the selection only between existing Clips. Any necessary gap will be closed or Clips moved out of the way.
- **Copy any Clip(s) with Pointer Tools:** Opt+drag the selected Clip(s). Same dragging behavior.

- **Move any Clip(s) with Position Tool:** Drag the selection freely to any position on the timeline. All the existing Clips will not change their position but might be (partially) overwritten. Gap Clips will be inserted if necessary.
- **Copy any Clip(s) with Position Tool:** Opt+drag the selected Clip(s). This is inconstant behavior because this time Clips can't be positioned freely. The Clip can only be positioned between Clips, same as Pointer Tool.

How about Connected Clips?
The moving of Clips gets much more complex when dealing with Connected Clips, additional Storylines, Compound Clip, etc. More on that in my next book. Just a few basic rules to start:

- **Moving with Connected Clips:** The big advantage of Connected Clips is that they latch on to the Clip on the Primary Storyline and when you move that Clip, all the Connected Clips will move with it (in sync). However, when you copy a Clip with opt+drag, only that Clip(s) on the Primary Storyline get copied, not its Connected Clips. For that you have to use the good old fashion copy-paste (to Playhead position) command.

- **Move Up:** This is not the official name of the command but it describes the action. You move a Clip from the Primary Storyline up to become a Connected Clip. But if you move the Clip up then there is not Clip on the Primary Storyline to connect to, right? Unless FCPx just created a Gap Clip and that is what the Connected Clip now is connected too. This is a perfect example why it's important to look at Gap Clips as actual Clips and not just gaps in the Timeline. You simply drag the Clip upwards, or use sh+drag to restrict the movement to the vertical position. The official command is “Lift from Primary Storyline”.

- **Move Down:** Basic concept but different outcome. The command is “Overwrite to Primary Storyline” and it moves the Connected Clip down to the Primary Storyline. However, only the video content will be overwritten, the audio will be “merged”, kind of. The audio track will be expanded and is available as a separate audio track.

Advanced Editing
Here is just a brief list of other editing features that I cover in my follow-up Manual “Final Cut Pro X - The Details”:

- **Disable:** It is like muting a Clip (video and audio).
- **Solo:** Disable the audio content of all Clips except the “soloed” one.
- **Expand/Collapse Audio:** Display the audio and video portion of a Clip separately for individual trimming.
- **Expand Audio:** Break out the audio portion into a separate Clip. Can't be reversed (except for immediate Undo)!
- **Compound Clips:** Group Connected Clips together (un-group them with the “Break Apart Clips” command).
- **Create Storyline:** Group Connected Clips together but with similar edit capabilities like the Primary Storyline (un-group them with the “Break Apart Clips” command).
- **Audition Clip:** Powerful new feature to have alternate Clip(s) in one Clip.
- **Precision Editor:** Double-click on the edit point to open the Precision Editor, press Enter to exit. This is a nice visual Editor to make the ongoing edit more transparent.
- **Multicam Clips:** Edit synchronized Clips.
Adding FX to a Clip

I touched the topic of Clip Properties before but especially in the context of editing in the Timeline it is very important to understand what is affecting what at what level. Here is the underlying concept again in a different graph:

1. You import a Media File into an Event. An Event Clip is created in the Event that is linked to that Media File. The Event Clip inherits the original Properties of the Media File. It is like a one time "lookup".

2. The Event Clip Properties can now be edited in the Inspector. You can change the inherited Properties and add new ones.

3. Now the Event Clip gets dragged onto the Project Timeline. A Timeline Clip is created on the Timeline that is linked to the Event Clip. The Timeline Clip now inherits the Properties of the Event Clip. Part of that Property is the location of the source Media File that the Event Clip is linked to. Again, this is a one time lookup.
   It is very important to understand why this copy process of the Properties is a one time "lookup" at the moment when the Timeline Clip is created. Any changes made in the Event Clip later on are not reflected in the Timeline Clip.

4. The Timeline Clip Properties can now be edited in the Inspector. Those changes are unique to that Timeline Clip. Any Clip that is placed on the Timeline carries its individual Properties that can be edited. Every time you drag an Event Clip from the Event Browser to the Timeline or copy a Timeline Clip on the Timeline, you create a new Timeline Clip. Each of those "new" Timeline Clips has its own Properties that can be edited independently in the Inspector.

5. If you play back the original Media File in the Finder (with QuickView), its own playback Properties apply. When you play back the Event Clip, then any playback instruction stored in the Event Clip Properties will apply when playing back the Media File. (i.e. play at -6dB). When you play back the Timeline Clip, any playback instruction stored in the Timeline Clip Properties will apply when playing back the Media File. (i.e. play with reverb, highly compressed and change the color tone of the video). Of course all those instructions are non-destructive playback instructions. The Media File stays untouched.

Editing the Properties for the Event Clip or the Timeline Clip is straightforward. You have the Inspector open cmd+4 and select the Clip. The Inspector displays the information from whatever Clip is selected and you go ahead and make any necessary changes in the Inspector.
The concept of applying playback parameters is very simple and easy: Every Clip has this Property List (kind of its DNA). That list carries:

- **Info**: General information about the Clip, its whole identity.
- **Video + Audio**: Playback parameters that have instructions on how to play back the audio and video portion of the Clip. These are the non-destructive playback instructions for the original Media File when played back as we have seen in the previous diagram. Those playback instructions are grouped in Modules in the Inspector.

There are two kinds of Modules:

- **Default Modules**: These Modules are already in the Property List and cannot be removed (only bypassed).
- **Effects Modules**: These are Modules only available for the Timeline Clips (not the Event Clips). Those effects can be added (drag or double-click) to the Timeline Clip from the Audio and Video Effects Browser window (open with `cmd`+5).

**Module GUI**

Most Modules have a bypass button

Parameters

Show/Hide parameters

Reset Parameter button

Keyframe Menu

- Reset Parameter
- Previous Keyframe
- Next Keyframe

Add/delete Keyframes at the current Playhead position (like Automation nodes, FCPx calls them Animation)

Here are the Inspector’s Property Lists with the default Modules in the Video and Audio tab. Please note that the Timeline Clips have a few more Modules plus the Effect Module. The Effect Module is a display section that groups all the Effects Modules inside like a container. It functions as an FX Rack where you can rearrange the order of the FX. The FX itself might even have its own separate GUI.
Transportation - Navigation

SMPTe Reader

The Background Render Display indicates the percentage how much of the current background render has been completed.

Click to toggle the Background Tasks Window

The Audio Meter Display has either 2 or 6 tracks depending on the Project property.

Click to toggle the Audio Meter window on-off. It extends to the right of the Timeline.

The SMPTE Clock displays mainly the position of the Playhead or Skimmer and corresponds with the Viewer window. This could be either from the Event or the Project. Besides that, it has multi-purpose functionality for displaying various time information and edit values.

Grey SMPTE:

- Displays the Playhead or Skimmer position.
- Displays the start position of a Connected Clip while dragging (not a Primary Storyline Clip).

Numeric Input Device:
The SMPTE Reader also functions as a numeric input device to enter a positive or negative time value. Use the period key as separator h.m.s and the esc key to cancel input.

There are two ways. Either you click on the SMPTE Reader or you start pressing the + or - key:

- Click on the SMPTE
  - Click once on the Display or press ctr+P for the Move Playhead command:
    It will reset the time display and show a blue Playhead instead of the Audio Meter. Now type + or - and the time you want to move the Playhead to the left or right.
  - Click twice on the Display to change the duration of a selected Clip. Keep in mind that this second click only works if a Clip is selected:
    The Display will show the duration of the Clip. Now type + or - and the amount of time you want to change the duration.

- Press + or -
  - Nothing selected: The entered value will move the Playhead.
  - Clip selected: The entered value will move the selected Clip.
  - Edit Point selected: The entered value will move the selected Edit Point.
Transportation

The Transport Control buttons in the Viewer window affect either the Event Browser or the Project Timeline whatever has key focus. The left upper corner of the Viewer indicates what is “feeding” the Viewer at the moment.

The standard “J K L” key commands still work: J plays backwards, K stops, L plays forward (press multiple times for faster speed).

The Navigation Controls can also be accessed from the Menu View > Playback or with Key Commands. The pre and post roll time for the “Play Around” command are set in the Preference > Playback window.

Zooming the Timeline

When zooming all the way in, the Playhead position displays a gray area in the SMPTE Timeline to indicate the range of 1 frame. The Skimmer will have that 1 frame “shadow” around it to indicate that frame range.

- Zoom to Fit everything: Sh+Z
- Zoom Command: Cmd+Plus, cmd+Minus. The Playhead or Skimmer (has priority) stays in “the picture” while zooming!
- Zoom Tool: Click-drag to select the zoom range or click in the Timeline to zoom step by step or opt-click to step out.
- Zoom Slider: Move the slider to click on the magnifier. Open the Clip Appearance window that includes a Clip Height slider.
Navigation

Playhead

This is the white bar that moves across the Timeline in the Project or across the Event Clip in the Event Browser. It indicates the position where the playback starts when hitting the play button and moves along during playback.

- **Dragging** along the upper time strip of the Timeline slides the Playhead. This will scrub the video but not the audio portion.
- **Clicking** on the upper time strip of the Timeline forces the Playhead to jump to that position (can be used with any cursor tool).
- **Clicking anywhere** in the Timeline will also place the Playhead there but might have different "slide effects" with cursor tools other than the Select tool. Clicking on a Clip will also deselect any current Clip selection. **Opt+click** will let you click on a Clip to select it without having the Playhead jump to the click position.
- Pressing the Key Command + or - will change the SMPTE Reader to indicate that you can enter a numeric time value to move the Playhead by that amount or **click** on the SMPTE Reader (before hitting the plus or minus key be sure that no Clip is selected because that would move the Clip and not the Playhead). Press **ctr+P** will also enable the input method.

Skimmer

When activated (Key Command **S**), the red bar will be displayed at the cursor position and video and audio will be scrubbed along the Clip(s) when moving the mouse across. The audio portion can be deactivated independently (Key Command **sh+S**).

- Moving the Skimmer will scrub the Project Timeline, the filmstrip in the Project Library or any Clip in the Event Browser.
- The Event Browser can display a Skimmer info window to display Keywords, Marker and time info (**View > Show Skimmer Info**).
- Clicking while in Skimming mode will move the Playhead to that click position.
- Starting playback (Key Command **space**) when the Skimmer is visible will move the Playhead to that position and start playback.

**Key Commands**

- Go to the **Beginning** of the Timeline: Key Command **home** or Menu Command **Mark > Go To > Beginning**.
- Go to the **End** of the Timeline: Key Command **end** or Menu Command **Mark > Go To > End**.
- Go to next **Clip Boundaries**: Key Command **arrow up and arrow down** or Key Command **; and 4** (also as Viewer buttons).
- Go to next **Frame**: Key Command **arrow left and arrow right** (also as Viewer buttons).
- Go to next **Sub Frame**: Key Command **cmd+arrow left and cmd+arrow right**.
- Go to next **Marker**: Key Command **ctr+; and ctr+1**.

All the commands are available from the **Mark** menu.

Timeline Index

Another new and powerful navigation tool is the Project’s Timeline Index. Open it with its own button or **sh+cmd+2**

This window shows a chronological list of all the Clips (Clips tab), all the Tags (Tags tab) that are used in the Timeline or the existing Roles. It provides Filter buttons at the bottom of the window to narrow down the listed items and a search box to look for specific Clips or Tags used in the Timeline.

- A white Playhead moves vertically that corresponds with the Playhead position on the Timeline.
- Selecting any item in the list will move the Playhead in the Timeline and select the Clip or its Fange with a gray border.

I will also get into more details about the Timeline Index in the manual “Final Cut Pro X - The Details”.

![Timeline Index - Clips](image1.png)
![Timeline Index - Tags](image2.png)
![Timeline Index - Roles](image3.png)
Conclusion

This concludes my “Final Cut Pro X - How it Works” manual. I hope I’ve helped you to understand the new concepts of the application and get you started. In the next manual “Final Cut Pro X - The Details”, I will dive into more details of all the topics and cover the more advanced features.

You can find more of my “Graphically Enhanced Manuals” on my website at: www.DingDingMusic.com/Manuals

All the titles are available as pdf downloads from my website and physical books on Amazon.com
Some titles are also available as Multi-Touch eBooks on Apple’s iBookstore. (language: English, Deutsch)

If you find my visual approach of explaining topics and concepts helpful, please recommend my books to others or maybe write a review on Amazon or the iBookstore. This will help me to continue this series.

Special thanks to my beautiful wife Li for her love and understanding during those long hours of working on the books. And not to forget my son Winston. Waiting for him during soccer practice always gives me extra time to work on a few chapters.

More information about my day job as a composer and links to my social network sites: www.DingDingMusic.com

To contact me directly, email me at: GEM@DingDingMusic.com

Thanks for your interest and your support,
Edgar Rothermich

Disclaimer: While every precaution has been taken in the writing of this manual, the author has no liability to any person or entity in respect to any damage or loss alleged to be caused by the instructions in this manual.

Some quotes (in italics) are from the original help document. Copyright © 2011 Apple Inc. All rights reserved.
Final Cut Pro, Motion are trademarks of Apple Computer, Inc., registered in the U.S. and other countries.